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The Great American Road belongs to Buick.




The 1988 Buick Dimension User’s
Guide for the Apple Macintosh
Application

Getting Started

Minimum Equipment:

¢ Apple Macintosh 512/512E, Macintosh Plus, Macintosh SE,
or Macintosh Il with a minimum of 512K RAM

¢ One 800K floppy disk drive, two 400K floppy disk drives, or
a hard disk.

Note: The Buick Dimension disk contains the most current
System available at the time of disk duplication. If you
have MultiFinder installed on your system, turn it off for opti-
mum performance of your Buick Dimension software.

Optional Equipment:
¢ ImageWriter, ImageWriter I, LaserWriter, or LaserWriter Plus

Starting the Program
To start the program using one 800K floppy disk:

1. Turn the computer on.

2. When the blinking question mark icon appears, put The
1988 Buick Dimension diisk in the internal drive (upper drive
on Mac SE).

The program loads into the computer automatically.



To start the program using two 400K floppy disks:

1. Turn the computer on.

2. When the blinking question mark icon appears, put The
1988 Buick Dimension disk marked Internal Drive in the
infernal drive (or upper drive on Mac SE) and the disk
marked External Drive in the external drive (or lower drive
on Mac SE).

The program loads into the computer automatically.

Note: When only one 400K drive is availalble, wait for the
disk marked Internal Drive to eject, then insert the disk
marked External Drive after the prompt appears.

To start the program using a hard disk:

. Make sure the computer is on and the Desktop is on the

screen.

2. Choose New Folder from the File menu and name the
folder icon that appears “Buick.”

3. Put The 1988 Buick Dimension 800K diisk or the 400K disk
marked Internal Drive in the internal floppy drive. When the
Buick Dimension icon appears, choose Select All from the
Edit menu and copy the files by dragging them to the
Buick folder you just created.

4. If two 400K disks are used, eject the disk marked Internal

Drive and replace it with the disk marked External Drive.

When the Buick Dimension icon appears, again choose

Select All from the Edit menu and copy the files to the Buick

folder.
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5. After the contents of the disk marked External Drive have
been copied, remove the disk from the drive.

6. Open the Buick folder and double click on the Buick tri-
shield logo application icon. The program loads into the
computer automatically.

Note: From now on you can start the program by repeating
step 6 above.

Opening Animation

The opening animation is the first thing to appear after the
program is loaded.

"Click The Mouse To Continue” appears near the bottom of
the screen. When you're in the opening segment of the
program, click the mouse butfon after this message
appears at the bottom of each screen to move to the next
screen.

The final screen in the opening segment of the program is
the Infegrity Statement. When the Integrity Statement
appears, look for the File and Showcase menus on the
menu bar along the fop of the screen.

The File Menu

To leave the program and return to the Desktop, choose
Quit from the File menu. When the copyright screen
appears, click the mouse button to go to the Desktop.



The Showcase Menu

The Showcase menu has two items from which to choose:

The New Reatta
The Buick Line

The New Reatta part of the program introduces you to the
advanced features of the Reatta — Buick's latest addition
to its line of fine automobiles.

The Buick Line gives you a broad range of information
about 20 different Buick models.

The New Reatta Showcase

The New Reatta Showcase presents the 1988 Buick Reatta.
It has menus that focus on the Reatta’s performance, han-
dling, comfort, and style. The initial Reatta screen allows
you to select the most exciting features of the Reatta by
clicking any of the four buttons at the bottom of the screen.

The Performance module letfs you — literally — peek info the
Reatta’s engine to see how it works. You'll find out about
such advanced features as its balance shaft and its
sequential fuel injection system (SFl).

The Handling module highlights the Reatta’s anti-lock orak-
ing system (ABS) and its transverse composite leaf spring
reqr suspension.

The Comfort module lefs you try out the Reatta’s 16-way
adjustable seats and its Electronic Control Center (ECC).

The Style module presents the Reatta’s exterior features,
aerodynamics, and body coating processes.

The Buick Line

The Model menu inside the Buick Line section lets you
select from the nine base models as well as provides
access to all 20 Buick models for 1988 by clicking More
Models. After selecting a model from the More Models
window, be sure to close the window by clicking on the
Close Box.

You can select from the items on the Buick Info menu to
view a slide show of the nine lbase models (Model Show-
case), display a list of the model’s fechnical data and fea-
tures, see your model’s interior and exterior dimensions,
choose an option package for your model, compare your
model with similar models from three other automobile
manufacturers, print a window sticker — even use a Pur-
chase Plan spreadsheet to estimate your monthly pay-
ments on the purchase of a particular Buick model.

Option packages are displayed by clicking one of the but-
tons at the bottom of the initial Option Package screen
causing a list of options to appear in a window. Closing the
Option Package window or selecting something from the
menu bar causes a dialogue box to appear giving you
the option to choose that option package. The selection of
a package for each model automatically excludes the
other packages for that model. The packages for each



model are categorized as Lightly Equipped, Medium
Equipped, and Heawvily Equipped.

The Purchase Plan spreadsheet automatically adds the
option package price fo and subtracts the package sav-
ings from the Base Price of the model you have selected.
After typing in the Down Payment amount, the Trade-in
Allowance, Number of Payments, and APR Interest Rate,
press the Return key after each entry. Your Estimated
Monthly Payment is automatically calculated on the
model you have selected.

Choose Invitation from the Buick Info menu for information
about the enclosed Buick “Diskount” Coupon that is
enclosed in the package with your Buick Dimension soft-
ware,

Menus and Interaction

Most inferaction throughout The 1988 Buick Dimension pro-
gram is through selection from the menu bbar across the
fop of the screen or by clicking on the buttons that appear
along the bottom of many screens. Click on these buttons
to see how components animate or fo display more infor-
mation. Some screens have additional user instructions
that appear in bold text in the column to the right or left of
the graphic element.

Click the Return bufton wherever displayed to go back to
the previous screen. When you reach a point in the pro-
gram where you cannot return to a previous screen,
choose a new item from one of the menus.

Printing from Buick Dimension

The Window Sticker can e printed to the ImageWriter by
clicking the Print Sticker button in the lower right corner of
the Window Sticker screen. In order to print the Window
Sticker to the LaserWriter you will have to run the Buick
Dimension program after starting up your Macintosh using
a standard Macintosh System.

The Purchase Plan, when displayed on the screen, can be
printed fo the ImageWriter by holding down the Com-
mand and Shift keys while you type the number 4.

Technical Notes

Before running the Buick Dimension program on a Macin-
tosh I, open the Control Panel in the Apple menu and set
the Monitor Control fo 2-color mode.

Apple Computer, Inc., makes no warranties, either express or implied regard-
ing the enclosed computer software package. Its merchantability or its fitness
for any particular purpose, the exclusion of implied warranties is not permitted
by some states. The above exclusion may not apply to you. This warrant pro-
vides you with specific legal rights. There may be other rights that you may
have which vary from stafe to state.

Macintosh System 4.1 and Finder 5.5 are copyrighted programs of Apple
Computer, Inc. licensed to General Motors Corporation, Buick Motor Division to
distribute for use only in combination with BUICK DIMENSION. Apple Software
shall not be copied onto another diskette (except for archive purposes) or into
memory unless as part of the execution of BUICK DIMENSION. When BUICK
DIMENSION has completed execution Apple Software shall not be used by any
other program. Apple is a trademark of Apple Computer, Inc.

All prices in US. dollars.






Thank you for your interest in Buick

To show our appreciation, there's a

$100.00 CASH ALLOWANCE
CERTIFICATE ENCLOSED

The Great American Road Belongs to Buick




BUICK MOTOR DIVISION, GENERAL MOTORS CORPORATION, FLINT, MI 48550

Dear Computer Owner:

Thank you for requesting the all new 1988 Buick
Dimension Disk.

The information on your Disk is designed to help you
make an intelligent purchase decision. It contains facts and
figures on all 1988 Buick models, and even includes selected
product information about our competitors.

Another exciting feature of the Disk you are about to
review is that it provides your first glimpse of the Reatta,
Buick’s luxury two-seater motorcar.

To show our appreciation for your interest in Buick,

we are also including a special $100.00 cash
allowance certificate. This may be used toward

the purchase or lease (GMAC Direct Lease Plan) of

any new and unused 1987 or 1988 Buick, except Reatta,
from February 13,1988 through June 30, 1988. The total
number of Cash Allowance Certificates available is
limited to the first 175,000 Buick Dimension Disks
issued. Complete details are on the reverse side

of the certificate.

Thank you again for test driving Buick by means of your
Dimension Disk. After you’ve reviewed it, we invite you to
visit your local Buick Dealer for an actual test drive.

Sincerely,

LS (ecz-

R.E. Coletta
General Sales
CASH ALLOWANCE CERTIFICATE NUMBER:  BD 131972 and Service Manager

Retain above portion.
Take portion below, including Certificate to any Buick Dealer.

Dealer Record: Save this portion for your reference.

Buick Dimension Disk
Caots Mlocvance Foecord
$100.00 CASH ALLOWANCE

Offer valid from February 13, 1988 through june 30, 1988*

Issued to S
Address —  Phone ———______
VIN of vehicle purchased — Delivery date

Certificate Number:

BD 131372

Certificate quantity limited to 175,000, nationally.

*May be used on any new and unused 1987 or 1988 model-year Buick except
Reatta, provided you take actual retail delivery between
February 13, 1988 and June 30, 1988.
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Take this certificate to any Buick Dealer

Buick Dimension Disk
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Cask ,
$100.00 xi'owanc:

Offer valid from February 13, 1988 through June 30, 1988*

Customer Name
Address
City State Zip

Cash Allowance: assigned to dealer to be mailed from Buick
Dealer Code Number Delivery Date

VIN of vehicle purchased
Dealer Firm Name
Address
City State Zip

Nt

i )

Dealer Signature Customer Signature

Your Certificate Number:

BD 131372

Certificate quantity limited to 175,000. nationally.

*May be used on any new and unused 1987 or 1988 model-year Buick except
Reatta, provided you take actual retail delivery between
February 13, 1988 and June 30, 1988.




Dealer: Retain this portion for reference

Program Rules

1. The retail purchase or GMAC DLP lease customer may choose to receive a cash allowance
directly from Buick Motor Division, or assign the cash allowance to the selling dealer.

If the cash allowance is assigned to the dealer, the retail purchaser's order must show the
cash allowance as a deduction from the vehicle purchase price, or in the case of a GMAC DLP
lease customer, as reducing the total lease obligation.

2. This Certificate must be presented to an authorized Buick dealer in the United States at the
time of retail purchase or GMAC DLP lease of any new and unused 1987 Buick Somerset
models or any new and unused 1987 or 1988 Buick Skyhawk, Skylark, Century, Regal, LeSabre,
Electra, Electra Park Avenue, Riviera or LeSabre/Electra station wagons. (Excluding Reatta)
3. Only the original certificate will be honored. Mechanical reproduction or facsimiles are not
valid. Certificate may be used only by assigned person or an immediate family member.

4. Only one certificate can be applied to the retail purchase or lease of an eligible vehicle.
This Certificate cannot be used with any other Buick Motor Division cerificate or coupon offer.
5. However, this certificate may be used in addition to any other consumer retail incentive
program that is available.

6. A vehicle sold or leased to a registered fleet customer is not eligible under this program,
regardless of whether fleet allowances or payments are available or claimed.

7. Total number of certificates available is limited to the first 175,000 Buick Dimension Disks
issued. Inquiries regarding this program should be made to the Buick Dimension Disk Center,
902 E. Hamilton Ave., Room #308, Flint, Ml 48550.

Dealer: Forward this portion to
Buick Cash Allowance Center for auditing

Include certificate number in the appropriate space when
entering the retail report. Complete the following information and
forward this Certificate to the Buick Dimension Disk Center,
902 E. Hamilton Ave., Room #308, Flint, MI 48550

Type of transaction: (Check one)
UJPurchase [C1GMAC Direct Lease Plan
Year, Make and Model of car TRADED (if none, N/A)

Optional Customer Profile:

Age — [ Male [IFemale

Marital Status (Check one) [ Married [JSingle []Divorced

Education (Check one) [] Less than 12 years High School Graduate
[J College Graduate  [] Post Graduate Study

How many cars in family?

(Jone [Jtwo [Jthree [ four, or more

Do you own a foreign car? [1yes [Jno

Do you own your own home? [J yes [ no, [] lease []rent

Annual household income: (Check one)

(] $15,000 to $19,999 [] $35,000 to $39,999 [] $55,000 to $59,999
[J $20,000 to $24,999 [J $40,000 to $44,999 [] $60,000 to $64,999
[J $25,000 to $29,999 [J $45.000 to $49,999 [] $65,000 to $69,999
(J $30,000 to $34,999 [J $50,000 to $54,999 [ $70,000 plus




